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Introduction to the project:

It is essential for modern society to ensure a clean, sustainable, secure and affordable energy supply. America's current energy challenge is meeting the projected increase in energy demand while decreasing dependence on foreign sources of energy. Although petroleum provides more energy for the United States than any other resource, domestic petroleum reserves and production are very limited. As a result, imports continue to grow and have reached over 70% of the US’s total petroleum consumption. A sustainable, renewable, and environmentally friendly energy resource is the desirable alternative.
Bioethanol is a liquid biofuel which can be produced from several different biomass feedstocks and conversion technologies. Bioethanol is the most employed liquid biofuel, either as a fuel or as a gasoline enhancer.  It is an attractive alternative fuel because it is a renewable, bio-based resource and it is oxygenated which provides the potential to reduce particulate emission in compression-ignition engines. Bioethanol itself has a higher octane number, broader flammability limits, higher flame speeds and higher heats of vaporization than gasoline. These properties allow for a higher compression ratio, shorter burn time and leaner burn engine, which lead to theoretical efficiency advantages over gasoline in an internal combustion engine. In summary, ethanol made from biomass has the greatest advantage with regard to environment, economics, and infrastructure.
General process of Bioethanol from Starch
Ethanol is commercially produced in one of the two ways: wet mill and dry mill process. The difference is that wet milling involves separating grain kernel into its component parts, e.g., germ, fiber, protein, and starch, prior to fermentation, and dry mill process ground the entire grain kernel into flour, the starch in the flour is converted into ethanol during fermentation process, emitting carbon dioxide and distillers’ grain. From chemistry point of view, the process can be written as follows:

                               Enzymes         Yeast                                                  

(C6H10O5)n + nH2O --->  nC6H12O6  --->  2nCH3CH2OH+ 2nCO2
Detailed processes are as follows (after starch-based biomass is collected and delivered to the ethanol production plant):

1. Pretreatment and milling. With dry mill process, the grain is screened to remove debris and ground into course flour. The milled grain then mixed with water to form a mash. During wet mill process, grain is soaked (steeped) in water and dilute sulfurous acid in order to separate grain into its many component parts. After soaking, the slurry is processed through a series of grinders, washing and filtering process to separate germ, fiber, and gluten, to form mash contained mainly starch and water. 

2. Enzymatic hydrolysis. The mash formed at above will undergo cooking process, at which point ammonia is added acting as both pH control and nutrient to yeast, enzymes (e.g. alpha-amylase) are added to convert starch into simple sugars, such as dextrose. 

3. Enzymatic hydrolysis continued. The mash is then processed with higher temperature to reduce bacteria levels, followed by pH and temperature adjustment suitable for the second enzyme. A second enzyme, usually glucoamylase is then added and the mixture is pumped into fermentation tanks.

4. Simultaneous saccharification fermentation. The glucoamylase enzyme breaks down the dextrins to form simple sugar (glucose) inside of the fermentation tanks. Yeast is then added into the tank to convert the simple sugar to ethanol and carbon dioxide. Fermentation results a mixture that contains about 15% ethanol and other materials, such as yeast, etc. 

5. Distillation. The fermented mash is then pumped into a multi-column distillation system where additional heat is added. The columns use the difference of the boiling point of ethanol and water to separate ethanol from mash. Ethanol is in the stream usually can be in 95% purity with water.

6. Dehydration. The distilled ethanol is then passing through molecular sieve to physically separate the remaining water. This is based on the different molecular size to produce anhydrous ethanol for storage or usage. 

Benefits of Using Model Simulation in Your Work
Model simulation is the recreation or reproduction of a particular process using computer software for analysis and forecasting purposes.  Here are some benefits of using model simulation for this project.
· Anticipate potential problems and risks: Support “what if “analysis.
· Justification for process improvement and technology adoption/transfer

· Know potential outcome of process conditions

· Will have a better understanding

· Training and learning

· Optimize Bioprocess

· Generate quicker computational results

· Savings

Bioprocess Simulation Model

The process model is developed using PRO II 8.2.  However, before creating a model in PRO II, the conversion rate from starch to glucose and glucose to ethanol need to be determined.  The conversion rate for starch is based on the following journal article: “Parameter Estimation for Simultaneous Saccharification and Fermentation of Food Waste into Ethanol Using Matlab Simulink” by Rebecca Anne Davis.  The conversion rate is based on 90 g/l of starch that produces 80 g/l of glucose which equates to 89% conversion rate.   
Next, to find the conversion rate from glucose to ethanol MATLAB will be used.  This is done by simulating the growth kinetics of ethanol production from glucose using the rate equations listed below.  The initial concentration of glucose is based on the above article. 
Optional See appendix A to generate both a numerical and graphical solutions of the concentration of glucose, ethanol and cells as a function of time using MATLAB.  You then can calculate the conversion form glucose to ethanol.
The rate equations for this process are given below:
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Assumptions Made to Generate a Process Model
· Steady state

· Starch is composed of 800 glucose units

· Ideal conditions

· Even though the conversion of starch and glucose is not 100%, the components were considered insignificant as product streams.
Using Pro II 8.2: Production of Ethanol from Starch
Part 1: Creating a new flow sheet
Step 1:  
Open PROII 8.2 icon by clicking start / All Programs / SIMSCI / Pro II 8.2 /PROII 8.2. The welcome window tells what operations are required by color designation: Red borders mean data and action required.  Green border means user may override this field. Blues borders mean that the data you filled in the entry field. Yellow borders mean that you supplied data outside the normal range of values for a field. 
Click OK on Welcome to PRO/II
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Step 2: Open new flow sheet. By clicking [image: image6.png]


 icon.
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Step 3: Save project by clicking[image: image8.png]


icon. Name the file Bioethanol from Starch and click Save.
NOTE: Click Save after each PART of this tutorial is done.

Step 4:  To change units of measurements there are two options.  

Option A:  Changes units for entire PFD.
 To set the units that will be used through out the PFD either select “Units of Measure” under the “Input” tab or click the[image: image9.png]


icon. Change Temperature to Celsius, Pressure to Pound/inch^2(abs), Weight(wt) to Kilogram, Liquid Volume to Meter^3, and Vapor Volume to Meter^3. Click OK.
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Option B:  Change units for each process unit ( See Part 2A below Step 15)
Part 2A:  Setting up library and hypothetical components
Step 1:   Add new component by pressing on [image: image11.png]


 icon.
Entering Library components: Type “Ethanol” in the Component Selection window.  Click Add.  Repeat the process for “Water” and “CO2”.
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Entering Hypothetical components: Enter two components that are not in the system by clicking on User-defined tab in the “Component Section” window. Type “Starch” in the “Component Name” box. Click “Add”.  Repeat for “Glucose”.
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NOTE:  You should see starch and glucose under the “Components to be Added”

You will get an alert when you press OK, warning that properties of the newly added components must be supplied, which we will take care of next.
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Step 2:  Click OK twice
NOTE: You should see five components in the list: ETHANOL, WATER, CO2, STARCH, and GLUCOSE.
Step 3:  Click OK
Step 4:  Click on component properties [image: image15.png]


 icon
Step 5:  Click on “Fill from structure” in the “Thermophysical properties” section.

Step 6:  Select Starch from “Available Components” and Click Move to “Components to be Filled”. Repeat for Glucose.
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Step 7: Click OK 
Step 8: Click UNIFAC Structures
Step 9: Click UNIFAC Structure for Starch in the component section.

[image: image17.png]Component Properties - UNIFAC Structures

Help Overview
Component
[ETRANDL UNIFAC Stuuchure.

ATER UNIFAC Struchure.
oz UNIFAC Struchure.
[ETARCH UINIFAE Sirugiure
[FIUCOSE UNIFAC Struchue.

o Cancel

[Puish to bring up the UNIFAC structures window





Step 10:  Enter components of the STARCH from the table below. Note starch is a polymer of D-glucose and has the following structure and we want to mimic it. Basically this is a polymer of Maltose molecules we call amylose. Hydrolysis of amylose takes place with enzymes that break down or hydrolyze starch into the constituent sugars. These enzymes are known as amylases and such α-amylases are found in plants and in animals. For example, human saliva is rich in amylase, and the pancreas also secretes the enzyme. These polymers typically have very high but indefinite molecular weights of 10,000 or so, and can be broken down through chemical pulping to 500 – 2000 MW molecules. These undergo liquefaction with amylase to maltose which is then converted to glucose with maltase. The following appears to be based on a MW of 800 repeating glucose units, i.e. 800 alcohols of the CH2OH type, 1600 alcohols of the –CHOH type, 1600 ethers (two per glucose, one on each end), and 2400 –CH paraffin groups (i.e. 4 –CH groups per glucose).
a. Under Category select “Alcohols”

b. Under “Group” select 0200
c. Click Add Group

d. Under “Number” column change “1” to “ 1600”

e. Repeat steps (a-d) until all the values have been inputted.  
	Category
	Group
	Number

	Alcohols
	0200
	1600

	Alcohols
	0277
	800

	Ethers
	0602
	1600

	Paraffins
	0902
	2400


NOTE: The window below should look similar after the completion of the table
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Step 11:  Click OK
Step 12:  Repeat Step 10 and Step 11 for GLUCOSE by using the values in the table below. Note glucose has the following structure and we want to mimic it with sub-molecular categories.
	Category
	Group
	Number

	Alcohols
	0200
	4

	Alcohols
	0214
	1

	Aldehyde
	0300
	1

	Paraffins
	0902
	3


These correspond to the following groups:
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In reality glucose in solution forms a ring structure (99.98% with only 0.02% in the straight chain form) so we really want to correct our sub-molecular components based on the following structure. We would simply replace the aldehyde group (=O) structure with an ether structure (-CH-O-C-), probably with No. 602 or perhaps No. 688.
Step 13: Click OK
Step 14:  Click Fixed in “Thermophysical properties” section. Enter the component properties of STARCH and GLUCOSE from the table below.
	Component
	Molecular Weight  (g/mol)
	Standard Liquid Density    (kg/m3)
	Normal Boiling Point  ( oC )

	Starch
	129600 
	1500
	250

	Glucose
	180
	1540
	150
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Step 15:  Click OK twice.

Important Note: The other option to change units is click the value under “Standard Liquid Density”. Then click UOM (Unit of Measurement), finally select desired units: kg/m3.
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Step 16: Select the thermodynamic package for the process calculations by either selecting Input tab on the menu bar and then click Thermodynamic Data or press the [image: image23.png]=



 icon on the tool bar.
Step 17: Under “Category” select Most Commonly Used
Step 18: Under “Primary Method” Select NRTL
Step 19:  Click Add
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Step 20: Click OK twice
Part 2B: Defining Reactions

Step 1: Click Input (menu bar) the select Reaction Data
Step 2: Under “Reaction Set Name”. Type “STARCH”, and then give a description.  Repeat for ETHANOL.  See screen below.
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Step 3: Click Enter Data for STARCH reaction.

Step 4: Click Red Box under “Name”. Enter “Starch” and click Red highlight letters “Reactants = Products”.
Step 5: Type “800” in the white box next to H20.  Type “1” for STARCH, and “800” for GLUCOSE.  

Note:  Then balance the reaction: Starch + 800 H20 = 800 Glucose  
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Step 6: Click OK twice

Step 7: Repeat steps 3-6, except type “ETHANOL” and in STEP 5, type “1” in the white box next to GLUCOSE.  Type “2” for C2H6O, and “2” for CO2. 
Note:  Then balance the reaction: Glucose = 2 C2H6O + 2 CO2 

Part 3: Creating a Process Flow Diagram (PFD)

Draw PFD that consists of two conversion reactors, simple heat exchanger and a distillation column connected with input and output streams as shown in figure bellow.
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Step 1: Click  View / Palettes / PFD 
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Part 4A: Creating Conversion Reactor (R1)
Step 1:  Click on Conversion Reactor R1 from the PFD pallet

Step 2:  Click Steams from the PDF pallet 

Step 3:  Connect inlet stream by dragging head of arrow to the left side of the reactor. Repeat the process for another inlet stream (total of two inlet streams).

Step 4:  Repeat the process, except use only one stream (outlet) and drag from the tail end of the arrow to the right side of the reactor.
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Step 5: Double click the input stream S1 and rename “WATER”. Then click on Flowrate and Composition under “Composition Defined” section. 
Step 6: Click Total Fluid Flowrate. Input “1000 kg-mole/hr”, and then under the “Composition Mole” section, input “1.00 Mole” for WATER. 
Step 7: Click on OK.
[image: image30.png]lowrate and Compos
Help

Speciy flowrate and compasiian for stieam WATER
Flid Flowate Speciication

@ Total P Flowrate: 1000.0] kgmalrhr

O Individual Component Flowrates

Copy Comporert Composiion
Pste Mole
JETHANDL
/ATER 1.0000]
[z
[ETARCH
[FIOTasE

Clear Compasiions_| Totat 10000 [] Nomalze Component Flawrales

Based on Specified Fhid Flowrate

Cancel

it the window after saving all data





Step 8:  Under “Thermal Condition”, make “First Specification” to be Temperature, and input “25 oC”; “Second Specification” to be Pressure and input “14.7 psia”.
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Step 9: Click OK
Step 10: Double click stream S2 and repeat step 5-9, except stream name “STARCH”, Total flow rate “1 kg-mole/hr”, Composition for starch “1 mole”. 

Step 11:  Double click stream S3, and rename “Glucose”.
Step 12: Click on the reactor R1 and under “Reaction Set Name” click STARCH. Type “1800C” for “Fixed Temperature”. Click on “Extent of Reaction” and under “Base Component” select Starch, and input “0.89” under conversion coefficient A.
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Step 13:  Click OK twice
Step 14: Click Run on the tool bar 
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Note: If reactor is blue then process to next step otherwise repeat PART: 3A

Part 4B: Creating Conversion Reactor (R2)
Step 1: Select another conversion reactor from the PFD pallet, then connect GLUCOSE stream to R2.
Step 2:  Select two more stream from the PDF pallet and connect on the right side of R2 (outlet streams).  Rename upper outlet stream “CO2” and lower stream “ETHANOL”.

Step 3: Double click R2.  Under “Reaction Set Name” click ETHANOL. Type “350C” for “Fixed Temperature”. Click on “Extent of Reaction” and under “Base Component” select GlUCOSE, and input “0.687” under conversion coefficient A.

Step 4: Click on Product Phases. Change phases according to the screen bellow. Under “Phases” select Vapor for CO2 and select Liquid for ETHANOL.

[image: image34.png]Reactor - Product Phases

Hep
Procucts: Phases

[ETFANGL Caid v
EH Vapor v

Cancel

Esit the window after saving ol data





Step 5: Click OK twice.
Step 6: Click Run [image: image35.png]


  icon

Note: If reactor is blue then process to next step otherwise repeat PART:4B

Part 5: Creating Simple Heat Exchanger

Step 1:  Select “Simple HX” from the PFD pallet.

Step 2:  Connect Ethanol stream from “R2” to left side of heat exchanger (HX).  Rename heat exchanger to “HX1”. Then connect one stream on the right hand side of the HX  (rename “FEED”)
Step 3: Double Click HX1, In the heat exchanger click Specification, then select “Hot Product temperature” and input 47 oC in the value box for temperature. 

[image: image36.png]Heat Exchanger - Specifications

UM Defne Range  Help

Speciicaion: [HotProduc Temperatwe v

e Toeroee:
. I
i  —

o Cancel

Enter the specification valus





Step 4: Click OK twice
Step 5: Click Run [image: image37.png]


  icon

Note: If reactor is blue then process to next step otherwise repeat PART:5
Part 6: Creating Distillation Column

Step 1: Select “Distillation” from PFD pallet.

Step 2:  Input “8” in the white box for number of trays, then click OK
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Step 3: Connect “FEED” stream to left side of distillation column where it reads “4” and draw one outlet PRODUCT stream for the top of column and one outlet WASTE stream for bottom of column. See below
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Step 4:  Double click Distillation column and click Pressure Profile
Step 5:  Input “14.7” pisa for top tray pressure, then click OK
Step 6:  Click Feeds and Products. Enter “4” in the white box under “tray” and then under “Rate” input “1196” kg-mol/hr for “PRODUCT”.  Input “385” kg-mol/hr for “WASTE”.
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Step 7: Click OK. Then click Yes.
Step 8: Click Performance Specifications, then under “Specifications” section 1 “COL1SPEC1” click the first blue parameter section change “Stream/ Unit” to Stream and “Stream Name” to Waste. Click OK. See screen below
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Step 9: click the second blue parameter section, change value to “200”.  Click OK .
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Step 10:  Click Condenser, then input “500C” in the “Temperature Estimate” white box.
Step 11: Click OK
Step 12:  Click Initial Estimates, Then change the temperatures as seen below.
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Step 12:  Click OK twice
Step 13: Step 5: Click Run [image: image44.png]


  icon

Note: If reactor is blue then procede to next step otherwise repeat PART 6.
Part 7: Results

TWO OPTOINS

OPTION A: 
Step 1: Click  [image: image45.png]


  on the tool bar to generate a report and save “Bioethanol from Starch”

Step 2: Save the file

OPTION B: 

Step 1: Click Output, select “Stream property Table”

Step 2:  Drag green box below the PFD and double click the green box.

Step 3:  Select “Stream Summary” under “Property List to be used”, then click Add All under “Stream Selection” section.
Step 4: Click OK
Step 5: Save the file
Note: Your process should look like the one shown below.
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APPENDIX A
MATLAB Background

There are two main windows that MatLab uses. The first window that pops up when MatLab opens is the command window.  This is where the main functions in Matlab are run.  The second window that Matlab uses is called the M-file editor.  This is where the Script file or M-miles are created. 

However, this tutorial will be very basic and will take show step-by-step to generate a numerical and graphical solution to find the conversion from glucose to ethanol. 

MATLAB Program
Step 1:  Open up Matlab.  

Create M-file (now called Script-file)
Step 2:  Click File→New→Script or type Ctrl+N.

Step 3:  Copy and paste Ethanol.m file below to M-file

Step 4:  Click File→Save and name file “Ethanol.m”

Step 5: Create another M-file (Script-file)
Step 6:  Copy and paste dydt3.m file below to new M-file and save file “ dydt3.m”

Step 7:  Under “Current Directory” double click Ethanol.m file

Step 8:  Press F5 on your keyboard

Step 9: You can edit the figure generated in MatLab by using the commands on the template in which it is generated then save it as a jpeg, bmp, etc. and put it in a report from the Insert tab in MS Word by clicking on the Picture icon.

· File, Save As, Glucose_to_EtOH.jpg
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Step 10: you can place the data into an ASCII output file by typing the command:

>> save Cornstarch_to_EtOH_data.out P –ASCII. You will now see a Cornstarch_to_EtOH_data.out appear in the Current folder which you can rename by right clicking on the file. You will now see for example:
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Step 11: You can bring that ASCII file into Excel as delimited data by:
Clicking on “Data” tab; selecting “From Text”; Find the file in a given folder (you will need to make sure “All Files” is selected; click on the “Cornstarch_to_EtOH_data.out” file and press import. Follow the directions for Fixed or Tab delineated data. 
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You can now produce a plot of the data in Excel which can easily be modified to look something like this.
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Use the Commands in Excel on the Layout tab to get the graph the way you want it.
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We can see from the data that Ethanol will not reach the critical and toxic level of 150 g/L given the initial glucose level. Other simulations can be done beginning with higher glucose levels and using Monod cell growth kinetic expressions that include product inhibition terms such as the two options below:
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MATLAB M-FILE-1: Ethanol.m

% The production of Ethanol from Glucose
% Given initial conditions and solving for three ODE's simultaneously, this program will plot
% the concentration of Glucose, Ethanol, and Biomass.  The plot will give
% the maximum ethanol produced bases on the substrate (glucose).
clear; clc;
% So -Initial substrate concentration (g/L)
% Eo -Initial ethanol concentration   (g/L)
% Xo -Initial biomass concentration   (g/L)
So = 80;
Eo = 0;
Xo = 1;
initial= [So Eo Xo]; % intial conditions of glucose, ethanol, and biomass
tspan = 0:1: 54.5;
[t,Y] = ode45(@dydt3,tspan,initial);
P= [t, Y];
disp (P);
plot(t, Y(:,1),t,Y(:,2),'-.',t,Y(:,3),'--'), xlabel ('t')
MATLAB M-FILE-1: dydt3.m

function Yprime = dydt3 (t,Y)
%Ks   -Substrate constant  (g/L)
%mu   -Maximum growth rate (g/L)
%Yxs  -Yield on substrate  (g/g)
%Ypx  -Yield on product    (g/g)
%ms   -Substrate maintenance rate constant ( g substrate/g biomass/hr )
%mp   -Product maintenance rate constant   ( g product/g biomass/hr )
Ks = 0.025;
mu = .045;
Yxs = 0.15;
Ypx = 5.33;
ms = 0.036;
mp = 0;
% Rate equations for glucose to ethanol process
Yprime = zeros(3,1);
Yprime (1)= -((mu*Y(1))/(Yxs*(Ks + Y(1)))+ ms)*Y(3);
Yprime (2)= (Ypx*(mu*Y(1))/(Ks + Y(1))+ mp)*Y(3);
Yprime (3)=(mu*Y(1))/(Ks + Y(1))*Y(3);
0
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_1224056129.unknown

_1224056193.unknown

_1395648306.unknown

_1224056098.unknown

